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Overview

 Macroscopes and the Changing Scientific Landscape 15 mins

 Introduction to network science with sample maps and insights 15 mins
 Introduction to the Network Workbench Tool 15 mins
 Demo and hands-on data analysis and visualization by participants 60 mins 

 Introduction to science studies with sample maps and insights 15 minsp p g
 Introduction to the Sci2 Tool 15 mins
 Demo and hands-on data analysis and visualization by participants 60 mins
 Overview of validation approaches for science studies pp

 Plug-and-play tool design using OSGi/CIshell 30 mins 
 Scholarly Marketplaces 15 mins Scholarly Marketplaces 5 mins 

240 mins
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These slides are available at

// / / /http://info.slis.indiana.edu/~katy/outgoing/10-NIH-Tutorial.pdf

The Changing Scientific Landscape

Star Scientist -> Research Teams: In former times, science was driven by key scientists. Today, science 
is driven by effectively collaborating co-author teams often comprising expertise from multiple 
disciplines and several geospatial locations (Börner Dall'Asta Ke & Vespignani 2005)disciplines and several geospatial locations (Börner, Dall Asta, Ke, & Vespignani, 2005).

Users -> Contributors: Web 2.0 technologies empower anybody to contribute to Wikipedia and to 
exchange images and videos via Fickr and YouTube. WikiSpecies, WikiProfessionals, or WikiProteins 
combine wiki and semantic technology in support of real time community annotation of scientific 
datasets (Mons et al., 2008). 

Cross-disciplinary: The best tools frequently borrow and synergistically combine methods and techniques 
from different disciplines of science and empower interdisciplinary and/or international teams of 
researchers, practitioners, or educators to fine-tune and interpret results collectively. 

One Specimen -> Data Streams: Microscopes and telescopes were originally used to study one specimen 
at a time. Today, many researchers must make sense of massive streams of multiple types of data with y, y p yp
different formats, dynamics, and origin.  

Static Instrument -> Evolving Cyberinfrastructure (CI): The importance of hardware instruments that 
are rather static and expensive decreases relative to software infrastructures that are highly flexible and 
continuously evolving according to the needs of different sciences. Some of the most successful 
services and tools are decentralized increasing scalability and fault toleranceservices and tools are decentralized increasing scalability and fault tolerance.

Modularity: The design of software modules with well defined functionality that can be flexibly combined 
helps reduce costs, makes it possible to have many contribute, and increases flexibility in tool 
development, augmentation, and customization.

Standardization: Adoption of standards speeds up development as existing code can be leveraged. It 
h l l i bili b l h i i f h dhelps pool resources, supports interoperability, but also eases the migration from research code to 
production code and hence the transfer of research results into industry applications and products.

Open data and open code: Lets anybody check, improve, or repurpose code and eases the replication of 
scientific studies.

44



Microscopes, Telescopes, and Macrocopes

Just as the microscope empowered our naked eyes to see cells, microbes, and viruses 
thereby advancing the progress of biology and medicine or the telescope opened our 
minds to the immensity of the cosmos and has prepared mankind for the conquest ofminds to the immensity of the cosmos and has prepared mankind for the conquest of 
space, macroscopes promise to help us cope with another infinite: the infinitely complex.  
Macroscopes give us a ‘vision of the whole’ and help us ‘synthesize’. They let us detect 
patterns, trends, outliers, and access details in the landscape of science. Instead of making 
things larger or smaller macroscopes let us observe what is at once too great too slow orthings larger or smaller, macroscopes let us observe what is at once too great, too slow, or 
too complex for our eyes. 
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Desirable Features of Plug-and-Play Macroscopes

Division of Labor: Ideally, labor is divided in a way that the expertise and skills of computer 
scientists are utilized for the design of standardized, modular, easy to maintain and extend “core 
architecture” Dataset and algorithm plugins i e the “filling” are initially provided by those thatarchitecture . Dataset and algorithm plugins, i.e., the filling , are initially provided by those that 
care and know most about the data and developed the algorithms: the domain experts. 

Ease of Use: As most plugin contributions and usage will come from non-computer scientists it must 
be possible to contribute, share, and use new plugins without writing one line of code. Wizard-
driven integration of new algorithms and data sets by domain experts, sharing via email or online 
i d l i l i b ddi h h ‘ l i ’ di d i h i Msites, deploying plugins by adding them to the ‘plugin’ directory, and running them via a Menu 

driven user interfaces (as used in Word processing systems or Web browsers) seems to work well.  
Plugin Content and Interfaces: Should a plugin represent one algorithm or an entire tool? What 

about data converters needed to make the output of one algorithm compatible with the input of 
the next? Should those be part of the algorithm plugin or should they be packaged separately? p g p g y p g p y

Supported (Central) Data Models: Some tools use a central data model to which all algorithms 
conform, e.g., Cytoscape, see Related Work section. Other tools support many internal data 
models and provide an extensive set of data converters, e.g., Network Workbench, see below. 
The former often speeds up execution and visual rendering while the latter eases the integration 
of new algorithms. In addition, most tools support an extensive set of input and output formats.of new algorithms. In addition, most tools support an extensive set of input and output formats. 

Core vs. Plugins: As will be shown, the “core architecture” and the “plugin filling” can be 
implemented as sets of plugin bundles. Answers to questions such as: “Should the graphical user 
interface (GUI), interface menu, scheduler, or data manager be part of the core or its filling?” will 
depend on the type of tools and services to be delivered. 

S d Pl f If h f i b d i W b i f h W b i d bSupported Platforms: If the software is to be used via Web interfaces then Web services need to be 
implemented. If a majority of domain experts prefers a stand-alone tool running on a specific 
operating system then a different deployment is necessary.
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CIs Developed and Served by CNS

Scholarly Database: 23 million scholarly records
http://sdb.slis.indiana.edu

Information Visualization Cyberinfrastructure
http://iv.slis.indiana.edu

Network Workbench Tool + Community Wiki
http://nwb.slis.indiana.edu

Sci2 Tool and Science of Science CI Portal
http://sci.slis.indiana.edu

Epidemics Cyberinfrastructure
http://epic.slis.indiana.edu/
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Computational Proteomics
What relationships exist between protein targets of all drugs and allWhat relationships exist between protein targets of all drugs and all 
disease-gene products in the human protein–protein interaction network?

Yildriim, Muhammed 

A., Kwan-II Goh, 

Michael E CusickMichael E. Cusick, 

Albert-László Barabási, 

and Marc Vidal. (2007). 

Drug-target Network. g g

Nature Biotechnology 

25 no. 10: 1119-1126.

Network Workbench (http://nwb.slis.indiana.edu).                                                                                                                           9
9

Computational Economics
Does the type of product that a yp p
country exports matter for 
subsequent economic performance? 

C A Hidalgo B KlingerC. A. Hidalgo, B. Klinger, 

A.-L. Barabási, R. Hausmann 

(2007) The Product Space 

Conditions the Development 

of Nations. Science 317, 

482 (2007).
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Computational Social Science
Studying large scale socialStudying large scale social 
networks such as Wikipedia

Vizzards 2007 Entry

Second Sight: An Emergent 
Mosaic of Wikipedian Activity, 
The NewScientist, May 19, 2007

Computational Epidemics
Forecasting (and preventing the effects of) the next pandemic.Forecasting (and preventing the effects of) the next pandemic.

Epidemic Modeling in Complex realities, V. Colizza, A. Barrat, M. Barthelemy, A.Vespignani, Comptes 
Rendus Biologie, 330, 364-374 (2007).

Reaction-diffusion processes and metapopulation models in heterogeneous networks, V.Colizza, R. 
Pastor-Satorras, A.Vespignani, Nature Physics 3, 276-282 (2007).

Modeling the Worldwide Spread 
of Pandemic Influenza: Baselineof Pandemic Influenza: Baseline 
Case and Containment 
Interventions, V. Colizza, A. 
Barrat, M. Barthelemy, A.-J. 
Valleron, A.Vespignani, 
PloS-Medicine 4, e13, 95-110 
(2007).

Network Workbench (http://nwb.slis.indiana.edu).                                                                                                                           12
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Network Workbench Tool
http://nwb.slis.indiana.edup

The Network Workbench (NWB) tool ( )
supports researchers, educators, and 
practitioners interested in the study of  
biomedical, social and behavioral science, 
physics, and other networks. 

In Aug. 2009, the tool provides more 160 
plugins that support the preprocessing, 
analysis, modeling, and visualization of  
networks. 

It has been downloaded more than 59,000 
times since October 2006.

Herr II, Bruce W., Huang, Weixia (Bonnie), Penumarthy, Shashikant & Börner, Katy. (2007). Designing Highly Flexible and Usable 
Cyberinfrastructures for Convergence. In Bainbridge, William S. & Roco, Mihail C. (Eds.), Progress in Convergence - Technologies for Human 
Wellbeing (Vol. 1093, pp. 161-179), Annals of  the New York Academy of  Sciences, Boston, MA. 
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Network Workbench Tool
http://nwb.slis.indiana.edup

Herr II, Bruce W., Huang, Weixia (Bonnie), Penumarthy, Shashikant & Börner, Katy. (2007). Designing Highly Flexible and Usable 
Cyberinfrastructures for Convergence. In Bainbridge, William S. & Roco, Mihail C. (Eds.), Progress in Convergence - Technologies for Human 
Wellbeing (Vol. 1093, pp. 161-179), Annals of  the New York Academy of  Sciences, Boston, MA. 
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Network Workbench Community Wiki
https://nwb.slis.indiana.edu/community
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Project Details

Investigators: Katy Börner, Albert-Laszlo Barabasi, Santiago Schnell, 
Alessandro Vespignani & Stanley Wasserman, Eric Wernert 

Software Team: Lead: Micah Linnemeier
Members: Patrick Phillips, Russell Duhon, Tim Kelley & Ann McCranie
Previous Developers: Weixia (Bonnie) Huang, Bruce Herr, Heng Zhang, 
Duygu Balcan, Bryan Hook, Ben Markines, Santo Fortunato, Felix 
Terkhorn, Ramya Sabbineni, Vivek S. Thakre & Cesar Hidalgoy g

Goal: Develop a large scale network analysis modeling and visualization toolkitGoal: Develop a large-scale network analysis, modeling and visualization toolkit 
for physics, biomedical, and social science research. 

Amount: $1,120,926, NSF IIS-0513650 award
Duration: Sept. 2005 - Aug. 2009  

//Website: http://nwb.slis.indiana.edu
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Project Details (cont.)

NWB Advisory Board:

James Hendler (Semantic Web) http://www.cs.umd.edu/~hendler/James Hendler (Semantic Web)  http://www.cs.umd.edu/ hendler/

Jason Leigh (CI)  http://www.evl.uic.edu/spiff/

Neo Martinez (Biology)  http://online.sfsu.edu/~webhead/

Michael Macy, Cornell University (Sociology) http://www.soc.cornell.edu/faculty/macy.shtml

Ulrik Brandes (Graph Theory)  http://www.inf.uni-konstanz.de/~brandes/

Mark Gerstein, Yale University (Bioinformatics)  http://bioinfo.mbb.yale.edu/

Stephen North (AT&T)  http://public.research.att.com/viewPage.cfm?PageID=81

T S ijd U i it f G i htt // t t l/ ijd /Tom Snijders, University of Groningen  http://stat.gamma.rug.nl/snijders/

Noshir Contractor, Northwestern University http://www.spcomm.uiuc.edu/nosh/
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NWB Tool: Supported Data Formats

Personal Bibliographies
 Bibtex (.bib) 

Network Formats
 NWB (.nwb) 

 Endnote Export Format (.enw) 

Data Providers
 Web of  Science by Thomson Scientific/Reuters (.isi)
 Scopus by Elsevier ( scopus)

 Pajek (.net) 
 GraphML (.xml or 

.graphml) 
 XGMML (.xml) 

 Scopus by Elsevier (.scopus)
 Google Scholar (access via Publish or Perish save as CSV, Bibtex, 

EndNote)
 Awards Search by National Science Foundation (.nsf)

Burst Analysis Format
 Burst (.burst)

O h FScholarly Database (all text files are saved as .csv)
 Medline publications by National Library of  Medicine 
 NIH funding awards by the National Institutes of  Health 

(NIH)
 NSF f di d b h N i l S i F d i (NSF)

Other Formats 
 CSV (.csv) 
 Edgelist (.edge) 
 Pajek (.mat) 
 T ML ( l) NSF funding awards by the National Science Foundation (NSF)

 U.S. patents by the United States Patent and Trademark Office 
(USPTO)

 Medline papers – NIH Funding

 TreeML (.xml)
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NWB Tool: Algorithms (July 1st, 2008)
See https://nwb.slis.indiana.edu/community and handout for details.
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NWB Tool: Output Formats

 NWB tool can be used for data conversion. Supported output formats comprise:

 CSV (.csv) ( )

 NWB (.nwb) 

 Pajek (.net) 

 Pajek ( mat) Pajek (.mat) 

 GraphML (.xml or .graphml) 

 XGMML (.xml) 

 GUESS

Supports export of images into pp p g

common image file formats.

 Horizontal Bar Graphs Horizontal Bar Graphs 

 saves out raster and ps files.

21

Overview

 Macroscopes and the Changing Scientific Landscape 15 mins

 Introduction to network science with sample maps and insights 15 mins
 Introduction to the Network Workbench Tool 15 mins
 Demo and hands-on data analysis and visualization by participants 60 mins 

 Introduction to science studies with sample maps and insights 15 minsp p g
 Introduction to the Sci2 Tool 15 mins
 Demo and hands-on data analysis and visualization by participants 60 mins
 Overview of validation approaches for science studies pp

 Plug-and-play tool design using OSGi/CIshell 30 mins 
 Scholarly Marketplaces 15 mins Scholarly Marketplaces 5 mins 

240 mins

22



NWB Tool Demo

A. Download, install, and run.

B. Load, view, convert, save data.

C. Read and visualize a directory hierarchy.y y

D. Load a network, compute its basic properties, and explore it in GUESS.

E Advanced community detection and scalable visualizationsE. Advanced community detection and scalable visualizations.

23

Software on DVD
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Download, Install, and Run 
(Demo DVD has all installers)

NWB Tool 1.0.0
Can be freely downloaded for all 

j ti t fmajor operating systems from 
http://nwb.slis.indiana.edu
Select your operating system from 
the pull down menuthe pull down menu. 
Save as *.jar file.
Install and run.

Session log files are stored in 
‘*yournwbdirectory*/logs’ directory.

NWB Demo DVD has all installers.

25

NWB Tool Interface Components 
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File, Preprocessing, Modeling, and Visualization Menus

27

Analysis Menu and Submenus 
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Integrated Tools

GUESS
Gnuplot

portable command-line driven 
interactive data and function plotting 
tilit http // n pl t inf /

exploratory data analysis and visualization tool 
for graphs and networks. 

https://nwb.slis.indiana.edu/community/?n=Vi
utility http://www.gnuplot.info/. sualizeData.GUESS. 

29

Supported Data Formats

In November 2008, the NWB tool supports loading the following input file formats:
 GraphML (*.xml or *.graphml)
 XGMML (*.xml)
 P j k NET (* t) & P j k M t i (* t) Pajek .NET (*.net) & Pajek .Matrix (*.mat)
 NWB (*.nwb)
 TreeML (*.xml)
 Edge list (*.edge)
 CSV (*.csv)
 ISI (*.isi)
 Scopus (*.scopus)
 NSF (*.nsf)
 Bibtex (*.bib)
 Endnote (*.enw) Endnote ( .enw)

and the following network file output formats:
 GraphML (*.xml or *.graphml)
 Pajek .MAT (*.mat)
 Pajek NET (* net) Pajek .NET (*.net)
 NWB (*.nwb)
 XGMML (*.xml)
 CSV (*.csv)

These formats are documented atThese formats are documented at 
https://nwb.slis.indiana.edu/community/?n=DataFormats.HomePage. 
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Sample Datasets

The ‘*yournwbdirectory*/sampledata’ directory provides sample datasets from the 
biology, network, scientometics, and social science research domains:

/biology
/network
/scientometrics
/ i i /bib/scientometrics/bibtex
/scientometrics/csv
/scientometrics/endnote
/scientometrics/isi/ /
 FourNetSciResearchers.isi
/scientometrics/nsf
 Cornell.nsf
 I di f Indiana.nsf
 Michigan.nsf
/scientometrics/scopus
/socialscience
 florentine.nwb

31

Property Files and Python Scripts

The ‘*yournwbdirectory*/” directory also contains

/sampledata/scientometrics/properties    // Used to extract networks and merge datap p p g
 bibtexCoAuthorship.properties
 endnoteCoAuthorship.properties
 isiCoAuthorship.properties
 isiCoCitation.properties
 isiPaperCitation.properties
 mergeBibtexAuthors.properties
 mergeEndnoteAuthors.properties
 mergeIsiAuthors.properties
 mergeNsfPIs.properties
 mergeScopusAuthors.properties
 nsfCoPI.properties
 scopusCoAuthorship.properties

/sampledata/scripts/GUESS // Used to do color/size/shape code networks 
 co-author-nw.py
 co-PI-nw.py
 paper-citation-nw.py paper citation nw.py
 reference-co-occurrence-nw.py
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NWB Tool Overview

A. Download, install, and run.

B. Load, view, convert, save data.

C. Read and visualize a directory hierarchy.y y

D. Load a network, compute its basic properties, and explore it in GUESS.

E Advanced community detection and scalable visualizationsE. Advanced community detection and scalable visualizations.
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Load, View and Save (Convert) Data 

Use 'File > Load File' to load florentine.nwb in sample datasets in

‘*yournwbdirectory*/sampledata/socialscience’.

The loaded file will appear in the Data 

Manager window.

Right click loaded file to save, view, rename, 

or discard.
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Data Converter Graph

There is no central data 
format.o .

Instead, data formats 
used in differentused in different 

communities and 
required by the different 

algorithms are g
supported. 

35
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E Advanced community detection and scalable visualizationsE. Advanced community detection and scalable visualizations.
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Reading and Visualizing a Directory Hierarchy

Use ‘File > Read Directory Hierarchy’ with parameters

Visualize resulting ‘Directory Tree - Prefuse (Beta) Graph’ using 

• ‘Visualization > Tree View (prefuse beta)’

• ‘Visualization > Tree Map (prefuse beta)’

• ‘Visualization > Balloon Graph (prefuse alpha)’

• ‘Visualization > Radial Tree/Graph (prefuse alpha)’Visualization  Radial Tree/Graph (prefuse alpha)

37

Different views of the 
/nwb directory 
hierarchy.y

Note the size of the 
/plugin directory.
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NWB Tool Overview
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C. Read and visualize a directory hierarchy.y y
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E Advanced community detection and scalable visualizationsE. Advanced community detection and scalable visualizations.
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Compute Basic NW Properties & View in GUESS

Select florentine.nwb in Data Manager.
 Run ‘Analysis > Network Analysis Toolkit (NAT)’ to get basic properties.

 Optional: Run ‘Analysis > Unweighted & Undirected > Node 
Betweenness Centrality’ with default parameters.

 Select network and run ‘Visualization > GUESS’ to open GUESS with file loaded.z p
 Apply ‘Layout -> GEM’.
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41

Pan:
“grab” the background 
by holding left-click 
and moving your 
mouse.

Zoom:
Using scroll wheel, g ,
press the “+” and “-” 
buttons in the upper-
left hand corner, or 
right-click and move 
h l f i hthe mouse left or right. 

Center graph by 
selecting ‘View -> 
Center’.

Select        to 
select/move single 
nodes Hold downnodes. Hold down 
‘Shift’ to select 
multiple.

Right click to modifyRight click to modify 
Color, etc.
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Graph Modifier:
Select “all nodes” in the Object 
drop-down menu and click ‘Show p
Label’ button. 

Select ‘Resize Linear > Nodes > 
totalities’ drop-down menu, then p ,
type “5” and “20” into the From” 
and To” Value box separately. 
Then select ‘Do Resize Linear’.

Select ‘Colorize> 
Nodes>totalities’, then select 
white and enter (204,0,51) in the 
pop-up color boxes on in the p p p
“From” and “To” buttons.

Select “Format Node Labels”, 
replace default text {originallabel} p { g }
with your own label in the pop-up 
box ‘Enter a formatting string for 
node labels.’

43

Interpreter:Interpreter:
Uses Jython a combination of  Java 
and Python.

TryTry
colorize(wealth, white, red)

resizeLinear(sitebetweenness, 5, 25) 
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Extract and Visualize Co-Author Network

Load*yournwbdirectory*/sampledata/scientometrics/isi/FourNetSciResearchers.isi’ 
using 'File > Load and Clean ISI File'.
T tr t th th r t rk l t th ‘361 U i ISI R d ’ t bl d rTo extract the co-author network, select the ‘361 Unique ISI Records’ table and run
'Scientometrics > Extract Co-Author Network’ using isi file format:

The result is an undirected network of co-authors 
in the Data Manager. It has 247 nodes and 891 edges. 

To view the complete network, select the network 
and run ‘Visualization > 
GUESS > GEM’. Run Script > Run Script… . 
And select Script folder > GUESS > co-author-nw.py.
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NWB Tool Overview

A. Download, install, and run.

B. Load, view, convert, save data.

C. Read and visualize a directory hierarchy.

D. Load a network, compute its basic properties, and explore it in GUESS.

E. Advanced community detection and scalable visualizations.
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Cluster Co-Author Network Hierarchically

To cluster a network into subnetworks hierarchically use the Blondel community detection 
algorithms running ‘Analysis > Weighted and Undirected > Blondel Community Detection‘ using 
numberofcoauthoredworks.f

Visualize result with ‘Visualization > Circular Hierarchy’.
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NWB Tool: GSView to View PS Files

GSview is a graphical interface for Ghostscript under MS-Windows, OS/2 and 
GNU/Linux. Ghostscript is an interpreter for the PostScript page description GNU/ . G os sc p s e p e e o e os Sc p p ge desc p o
language used by laser printers. For documents following the Adobe PostScript 
Document Structuring Conventions, GSview allows selected pages to be viewed or 
printed. GSview 4.9 requires Ghostscript 7.04 - 9.99. 

On Sci2 Tool DVD run

/PSView/gsview/gsview32 exe/PSView/gsview/gsview32.exe

File > Open 
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Type of Analysis vs. Scale of Level of Analysis

Micro/Individual
(1 100 d )

Meso/Local
(101 10 000 d )

Macro/Global
(10 000 d )(1-100 records) (101–10,000 records) (10,000 < records) 

Statistical 
Analysis/Profiling 

Individual person and 
their expertise profiles

Larger labs, centers, 
universities, research 
domains, or states

All of NSF, all of USA, 
all of science.

,

Temporal Analysis 
(When)

Funding portfolio of 
one individual

Mapping topic bursts 
in 20-years of PNAS

113 Years of physics 
Research

Geospatial Analysis 
(Where)

Career trajectory of one 
individual  

Mapping a states 
intellectual landscape

PNAS publications 

Topical Analysis Base knowledge from Knowledge flows in VxOrd/Topic maps ofTopical Analysis 
(What)

Base knowledge from 
which one grant draws.

Knowledge flows in 
Chemistry research 

VxOrd/Topic maps of 
NIH funding

Network Analysis 
(With Whom?)

NSF Co-PI network of 
one individual

Co-author network NSF’s core competency 
(With Whom?) one individual  
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Type of Analysis vs. Scale of Level of Analysis

Micro/Individual
(1 100 d )

Meso/Local
(101 10 000 d )

Macro/Global
(10 000 d )(1-100 records) (101–10,000 records) (10,000 < records) 

Statistical 
Analysis/Profiling 

Individual person and 
their expertise profiles

Larger labs, centers, 
universities, research 
domains, or states

All of NSF, all of USA, 
all of science.

Common analysis types are ,

Temporal Analysis 
(When)

Funding portfolio of 
one individual

Mapping topic bursts 
in 20-years of PNAS

113 Years of Physics 
Research

• Temporal
• Geospatial
• Topical 

Geospatial Analysis 
(Where)

Career trajectory of one 
individual  

Mapping a states 
intellectual landscape

PNAS publciations 

Topical Analysis Base knowledge from Knowledge flows in VxOrd/Topic maps of

• Network
or combinations thereof. 
The data used determines the scope of  the analysis. 
W l li t th i l i lTopical Analysis 

(What)
Base knowledge from 
which one grant draws.

Knowledge flows in 
Chemistry research 

VxOrd/Topic maps of 
NIH funding

Network Analysis 
(With Whom?)

NSF Co-PI network of 
one individual

Co-author network NIH’s core competency 

We also list the main analysis goal.

(With Whom?) one individual  
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Mapping Indiana’s Intellect al SpaceMapping Indiana’s Intellectual Space

Id ifIdentify

 Pockets of  innovation

 Pathways from ideas to products

 I l f i d d d i

Geospatial/Network Analysis 
2001-2006, BioMed, IN Scope
Academic-Industry collaborations and knowledge diffusion

 Interplay of  industry and academia
y k g ff
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Mapping Topic Bursts

Co-word space of 
the top 50 highly 
frequent and burstyfrequent and bursty 
words used in the 
top 10% most 
highly cited PNAShighly cited PNAS 
publications in 
1982-2001.

Temporal/Topical Analysis 
1982-2001, US, PNAS (BioMed) Scope
Topic evolution and bursts

Mane & Börner. (2004) 
PNAS, 101(Suppl. 1):
5287-5290.

p
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Spatio-Temporal Information Production and Consumption of  Major U.S. 
Research Institutions
Börner, Katy, Penumarthy, Shashikant, Meiss, Mark and Ke, Weimao. (2006) 
M i h Diff i f S h l l K l d A M j U S R hMapping the Diffusion of  Scholarly Knowledge Among Major U.S. Research 
Institutions. Scientometrics. 68(3), pp. 415-426.

Research questions:
1 Does space still matter1.    Does space still matter 

in the Internet age? 
2.   Does one still have to 

study and work at major research y j
institutions in order to have access to 
high quality data and expertise and to produce high 
quality research? 

3 D h I l d l b l i i

Temporal/Geospatial Analysis 
1982-2001, US, PNAS (BioMed) Scope
Citation impact and knowledge diffusion3.   Does the Internet lead to more global citation 

patterns, i.e., more citation links between papers 
produced at geographically distant research 
instructions?

p k g ff

Contributions:
 Answer to Qs 1 + 2 is YES.
 Answer to Qs 3 is NO.
 N l h l i h d l l f Novel approach to analyzing the dual role of 

institutions as information producers and 
consumers and to study and visualize the diffusion 
of information among them. 55

Research Collaborations by the Chinese Academy of  Sciences
By Weixia (Bonnie) Huang, Russell J. Duhon, Elisha F. Hardy, Katy Börner, Indiana University, USA

Geospatial Analysis 
World, Chinese Academy of  Science
Collaboration and knowledge diffusion via co-author networks

This map highlights the research co-authorship collaborations of the Chinese Academy of 
Sciences with locations in China and countries around the world. The large geographic map 
shows the research collaborations of all CAS institutes. Each smaller geographic map shows the 
research collaborations by the CAS researchers in one province-level administrative division

k g ff k

research collaborations by the CAS researchers in one province level administrative division. 
Collaborations between CAS researchers are not included in the data. On each map, locations 
are colored on a logarithmic scale by the number of collaborations from red to yellow. The 
darkest red is 3,395 collaborations by all of CAS with researchers in Beijing. Also, flow lines are 
drawn from the location of focus to all locations collaborated with The width of the flow line isdrawn from the location of focus to all locations collaborated with. The width of the flow line is 
linearly proportional to the number of collaborations with the locations it goes to, with the 
smallest flow lines representing one collaboration and the largest representing differing amounts 
on each geographic map.
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Individual Co-PI Network 
Ke & Börner, (2006)

Temporal/Network Analysis
2001-2006, US, InfoVis Scope
Evolving project-PI networks
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Mapping the Evolution of  Co-Authorship Networks 
Ke, Visvanath & Börner, (2004) Won 1st price at the IEEE InfoVis Contest.
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Temporal/Network Analysis
1986-2004, US, InfoVis Scope
Evolving co-author networks and author impact
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Studying the Emerging Global Brain: Analyzing and Visualizing the Impact of  
Co-Authorship Teams 
Börner Dall’Asta Ke & Vespignani (2005) Complexity 10(4):58 67

Research question:

• Is science driven by prolific single experts 

Börner, Dall Asta, Ke & Vespignani (2005) Complexity, 10(4):58-67.

s sc e ce d ve by p o c s g e e pe ts
or by high-impact co-authorship teams?

Contributions:

• New approach to allocate citational 
credit.

• Novel weighted graph representation.Temporal/Network Analysis
• Visualization of the growth of weighted 

co-author network. 

• Centrality measures to identify author 
i

1986-2004, US, InfoVis Scope
Impact of  co-author relations

impact.

• Global statistical analysis of paper 
production and citations in correlation 
with co-authorship team size over timewith co authorship team size over time.

• Local, author-centered entropy measure.
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113 Years of  Physical Review
http://scimaps.org/dev/map_detail.php?map_id=171
Bruce W. Herr II and Russell Duhon (Data Mining & Visualization), Elisha F. Hardy (Graphic Design), Shashikant 
Penumarthy (Data Preparation) and Katy Börner (Concept)

Topical/Network Analysis 
1893-2006, World, Physics Scope
Topic evolution, knowledge diffusion, Nobel predictionsp , k g ff , p
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Topical Composition and Knowledge Flow Patterns in Chemistry Research for 
1974 and 2004
Kevin W. Boyack, Katy Börner, & Richard Klavans (2007)

Temporal/Network Analysis
1974-2004, US, NSF Chemistry Funding Scope
Mapping the main structure, topic evolution, and knowledge diffusion
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C R01 i i b d f di i h TTURC

Mapping Transdisciplinary Tobacco Use Research 
Centers Publications
Compare  R01 investigator based funding with TTURC 
Center awards in terms of number of publications and 
evolving co-author networks.
Z & Bö f th iZoss & Börner, forthcoming.

Temporal/Network Analysis
1998-2009, US, Tobacco Research Scope
Comparing co-author networks with different funding 
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Duhon & Börner forthcoming

Reference Mapper

Duhon & Börner, forthcoming.

Topical/Network Analysis
2009, US, NSF Funding
Grouping interdiciplinary funding proposals for review
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Latest ‘Base Map’ of Science
Kevin W. Boyack, Katy Börner, & Richard Klavans (2007). Mapping the Structure and Evolution of 
Ch i R h 11 h I i l C f S i i d I f i 112 123Chemistry Research. 11th International Conference on Scientometrics and Informetrics. pp. 112-123. 

 Uses combined SCI/SSCI 
from 2002

Math
Law

• 1.07M papers, 24.5M 
references, 7,300 journals

• Bibliographic coupling of 
p p r r t d t

Policy

Economics

Statistics

CompSci
Phys-Chem

Computer Tech

papers, aggregated to 
journals

 Initial ordination and clustering 
of journals gave 671 clusters

Physics

GeoScience

Brain

Psychiatry
Environment

Vision Chemistry

Psychology

Education

of journals gave 671 clusters
 Coupling counts were 

reaggregated at the journal 
cluster level to calculate the 

Biology

Microbiology

BioChem

MRI

Bio-
Materials

Pl t

• (x,y) positions for each 
journal cluster

• by association, (x,y) 
i i f h j l

Virology Infectious Diseases

Cancer

Disease &
Treatments

Plant

Animal

positions for each journal
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Science map applications: Identifying core competency
Kevin W. Boyack, Katy Börner, & Richard Klavans (2007). 

Funding patterns of  the US Department of  Energy (DOE)

Policy Statistics

Math
Law

Computer Tech

Economics
CompSci

PhysicsVision

Phys-Chem

ChemistryEducation

Biology

GeoScience

BioChem

Brain

Psychiatry
Environment

MRI

Bi

Psychology

GI

Microbiology

BioChem

Cancer

Bio-
Materials

Plant

Animal

GI

Virology Infectious Diseases
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Science map applications: Identifying core competency
Kevin W. Boyack, Katy Börner, & Richard Klavans (2007). 

Funding Patterns of  the National Science Foundation (NSF)

Policy Statistics

Math
Law

Computer Tech

Economics
CompSci

PhysicsVision

Phys-Chem

ChemistryEducation

Biology

GeoScience

BioChem

Brain

Psychiatry
Environment

MRI

Bi

Psychology

GI

Microbiology

BioChem

Cancer

Bio-
Materials

Plant

Animal

GI

Virology Infectious Diseases
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Science map applications: Identifying core competency
Kevin W. Boyack, Katy Börner, & Richard Klavans (2007). 

Funding Patterns of  the National Institutes of  Health (NIH)

Policy Statistics

Math
Law

Computer Tech

Economics
CompSci

PhysicsVision

Phys-Chem

ChemistryEducation

Biology

GeoScience

BioChem

Brain

Psychiatry
Environment

MRI

Bi

Psychology

GI

Microbiology

BioChem

Cancer

Bio-
Materials

Plant

Animal

GI

Virology Infectious Diseases
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Science map applications: Identifying core competency
Kevin W. Boyack, Katy Börner, & Richard Klavans (2007). 

Funding Patterns of  the National Institutes of  Health (NIH)

Policy Statistics

Math
Law

Computer Tech

Economics
CompSci

PhysicsVision

Phys-Chem

ChemistryEducation Topic/Network Analysis

Biology

GeoScience

BioChem

Brain

Psychiatry
Environment

MRI

Bi

Psychology

GI

2002, World, Science/Social Science & DOE/NSF/NIH 
Funding Scope
Map main structure of  science and funding profiles 

Microbiology

BioChem

Cancer

Bio-
Materials

Plant

Animal

GI

Virology Infectious Diseases
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Interactive Science Map of NIH Funding
Herr II, Bruce W., Talley, Edmund M, Burns, Gully APC, Newman, David & La Rowe, Gavin. (2009). 

Topic/Network Analysis
2007, US, NIH Funding Scope
Map main structure of  NIH funding and institutes’ funding profiles 

http://scimaps.org/maps/nih/2007

70



Interactive World and Science Map of S&T Jobs
Angela Zoss, Michael Connover, Katy Börner (2010). 

Geospatial/Topic Analysis
2008/2009, World, 100 Job RSS feeds
Map evolving job market in real time
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Computational Scientometrics:

Studying Science by Scientific Meansy g y

Börner, Katy, Chen, Chaomei, and Boyack, Kevin. (2003). 
Visualizing Knowledge Domains. In Blaise Cronin 
(Ed ) ARIST Medford NJ: Information Today(Ed.), ARIST, Medford, NJ: Information Today, 
Inc./American Society for Information Science and 
Technology, Volume 37, Chapter 5, pp. 179-255. 
http://ivl.slis.indiana.edu/km/pub/2003-borner-arist.pdf

Shiffrin, Richard M. and Börner, Katy (Eds.)  (2004). 
Mapping Knowledge Domains. Proceedings of  the 
National Academy of  Sciences of  the United States of  America, 
101(Suppl_1). 
http://wwwpnas org/content/vol101/suppl 1/http://www.pnas.org/content/vol101/suppl_1/

Börner, Katy, Sanyal, Soma and Vespignani, Alessandro 
(2007). Network Science. In Blaise Cronin (Ed.), ARIST, 
Information Today, Inc./American Society for d y, / y
Information Science and Technology, Medford, NJ, 
Volume 41, Chapter 12, pp. 537-607. 

http://ivl.slis.indiana.edu/km/pub/2007-borner-arist.pdf

Börner, Katy (2010) Atlas of  Science. MIT Press.
http://scimaps.org/atlas
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There are many more questions than answers: First results from a 
questionnaire study on insights needed by science policy makersquestionnaire study on insights needed by science policy makers
Priority scale of 1-5, with 1=urgent to 5=nice to know

Priority          Questions
Temporal Analysis
1 f di d i i di id l i i ll NIH ll f di / T i l i NIH i ifi i b dl d i d il1 funding trends in individual institutes, all NIH, all funding / Topical – to examine NIH scientific topic area broadly and in detail 
1 Topical/temporal – how are the current structures of scientific/translational/clinical research changing, what are the emerging areas, and 

how are the submitted applications different from awarded grants in these areas.  
2 What new biomedical fields of research are emerging, and 1) is NIH currently funding such research, 2) are there enough trained 

scientists to address these new research fields, and 3) where is the emerging fields research being conducted (are there geographic 
clusters)?

2 T l f di ib i / T l i i ifi d2 Temporal patterns of distribution / Temporal – examine scientific trends
3 What are the prevailing trends in topics receiving funding across NIH? By specific institute? 
3   Meso vs global (topical/temporal) – how does NIH funding relate to funding from other agencies/countries

Geospatial Analysis
1 Diffusion of knowledge globally1 Diffusion of knowledge globally
5 Have there been any changes in degree of international collaboration in the biomedical sciences?

Topic Analysis 
1 What NIH Funds / How do we identify emerging concept / Are there emerging areas of opportunity to which NIH should direct more

support?
1 How are NIH research findings being used by partners, health providers and the public? 
2 How do we identify gaps in knowledge?
2 How can we characterize (or categorize) the research that NIH supports? AND How do these areas of investment compare to public

health needs?

Network AnalysisNetwork Analysis
2 How can we quickly understand the current network of nodule and collaboration? What information will we need to do so?
4 Have our efforts to encourage interdisciplinary research been effective?  And which strategies have been the most effective?
? Identify instances of knowledge transfer within and across research networks  
? Network approaches to measuring or detecting innovation? E.g. publication or concept that disturbs the stability of a network.
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The Science of Science (Sci2) Tool

 Explicitly designed for SoS research and practice, well documented, easy to use. 

 E di hil ki i f Empowers many to run common studies while making it easy for exports to 
perform novel research.

 Advanced algorithms, effective visualizations, and many (standard) workflows. 

 Supports micro-level documentation and replication of studies.

 Is open source—anybody can review and extend the code, or use it for 
commercial purposes.
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BREAK

Overview

 Macroscopes and the Changing Scientific Landscape 15 mins

 Introduction to network science with sample maps and insights 15 mins
 Introduction to the Network Workbench Tool 15 mins
 Demo and hands-on data analysis and visualization by participants  60 mins 

 Introduction to science studies with sample maps and insights 15 minsp p g
 Introduction to the Sci2 Tool 15 mins
 Demo and hands-on data analysis and visualization by participants 60 mins
 Overview of validation approaches for science studies pp

 Plug-and-play tool design using OSGi/CIshell 30 mins 
 Scholarly Marketplaces 15 mins Scholarly Marketplaces 5 mins 

240 mins
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NWB Tool vs. Science of Science (Sci2) Tool

Similarities:

 Both use OSGi/CIShell and are easy to extend/customize.

 Same general interface, look and feel.

 Sci2 uses many NWB plugins.y p g

Differences:

 Different target communities branding tutorials Different target communities, branding, tutorials. 

 Both come with different OSGi/CIShell plugin sets, sample datasets, and menu 
structures.

 S i2 h d b hi h k i l bl Sci2 has database support which makes it more scalable.

 Sci2 has improved GUESS functionality.

 Sci2 has more standard workflows and visualizations.

 Sci2 (alpha 0.3) is less mature than NWB (v 1.0).
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Sci2 Tool for Science of Science 
Research and Practice  (See Demo DVD)
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Process of Computational Scientometrics

, Topics

Börner, Katy, Chen, Chaomei, and Boyack, Kevin. (2003) Visualizing Knowledge Domains. In Blaise Cronin (Ed.), Annual 
R i f I f ti S i & T h l V l 37 M df d NJ I f ti T d I /A i S i t fReview of  Information Science & Technology, Volume 37, Medford, NJ: Information Today, Inc./American Society for 
Information Science and Technology, chapter 5, pp. 179-255. 
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Needs-Driven Workflow Design 
using a modular data acquisition/analysis/modeling/visualization 

i li ll d l i li i lpipeline as well as modular visualization layers.

Börner, Katy (2010) Atlas of  Science. MIT Press. 80



Sci2 Tool: Algorithms 
See https://nwb.slis.indiana.edu/community

Preprocessing
Extract Top N% Records
Extract Top N Records
Normalize Text

Modeling
Random Graph
Watts-Strogatz 
Small World

Weighted & Undirected
Clustering Coefficient
Nearest Neighbor Degree
Strength vs Degree

Slice Table by Line
---------------------------------------------
Extract Top Nodes
Extract Nodes Above or Below Value
Delete Isolates

Barabási-Albert Scale-Free
TARL

Analysis
Network Analysis Toolkit (NAT)

g g
Degree & Strength
Average Weight vs End-point Degree
Strength Distribution
Weight Distribution
Randomize Weights

---------------------------------------------
Extract top Edges
Extract Edges Above or Below Value
Remove Self Loops
Trim by Degree
MST Pathfinder Network Scaling

Unweighted & Undirected
Node Degree
Degree Distribution
---------------------------------------------
K-Nearest Neighbor (Java)
Watts Strogatz Clustering Coefficient

---------------------------------------------
Blondel Community Detection
---------------------------------------------
HITS

Unweighted & Directed
Node IndegreeMST-Pathfinder Network Scaling

Fast Pathfinder Network Scaling
---------------------------------------------
Snowball Sampling (in nodes)
Node Sampling
Edge Sampling

Watts-Strogatz Clustering Coefficient
Watts Strogatz Clustering Coefficient over K
---------------------------------------------
Diameter
Average Shortest Path
Shortest Path Distribution

Node Indegree
Node Outdegree
Indegree Distribution
Outdegree Distribution
---------------------------------------------
K-Nearest Neighborg p g

---------------------------------------------
Symmetrize
Dichotomize
Multipartite Joining
---------------------------------------------
G d

Node Betweenness Centrality
---------------------------------------------
Weak Component Clustering
Global Connected Components
---------------------------------------------

C

Single Node in-Out Degree Correlations
---------------------------------------------
Dyad Reciprocity
Arc Reciprocity
Adjacency Transitivity
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Geocoder
---------------------------------------------
Extract ZIP Code

Extract K-Core
Annotate K-Coreness
---------------------------------------------
HITS

---------------------------------------------
Weak Component Clustering
Strong Component Clustering
---------------------------------------------

Sci2 Tool: Algorithms cont.
See https://nwb.slis.indiana.edu/community

--------------------------------

Extract K-Core

Annotate K Coreness

Visualization
GnuPlot
GUESS

Scientometrics
Remove ISI Duplicate Records
Remove Rows with Multitudinous FieldsAnnotate K-Coreness

--------------------------------

HITS

PageRank

Weighted & Directed

Image Viewer
---------------------------------------------
Radial Tree/Graph (prefuse alpha)
Radial Tree/Graph with Annotation 

(prefuse beta)
T Vi ( f b )

Detect Duplicate Nodes
Update Network by Merging Nodes
---------------------------------------------
Extract Directed Network
Extract Paper Citation Network
E A h P N kHITS

Weighted PageRank

Textual

Burst Detection

Tree View (prefuse beta)
Tree Map (prefuse beta)
Force Directed with Annotation 

(prefuse beta)
Fruchterman-Reingold with Annotation 

(prefuse beta)

Extract Author Paper Network
---------------------------------------------
Extract Co-Occurrence Network
Extract Word Co-Occurrence Network
Extract Co-Author Network
Extract Reference Co-OccurrenceBurst Detection (prefuse beta)

---------------------------------------------
DrL  (VxOrd)
Specified (prefuse beta)
---------------------------------------------
Horizontal Line Graph

Extract Reference Co Occurrence 
(Bibliographic Coupling) Network

---------------------------------------------
Extract Document Co-Citation Network

Circular Hierarchy
Geo Map (Circle Annotation Style)
Geo Map (Colored-Region Annotation Style)
*Science Map (Circle Annotation)
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* Requires permission from UCSD              General Network extraction
All four+ save into Postscript files.



Network Extraction

Sample paper network (left) and four different network types derived from it (right).
From ISI files, about 30 different networks can be extracted.,
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Sci2 Tool

Plugins that render into Postscript files:

Sci Maps
Geo Maps

Horizontal Time Graphs

Börner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Duhon, Russell Jackson, Phillips, Patrick, Ma, 
Nianli, Zoss, Angela,  Guo, Hanning & Price, Mark. (2009). Rete-Netzwerk-Red: Analyzing and 
Visualizing Scholarly Networks Using the Scholarly Database and the Network Workbench Tool. 
Proceedings of ISSI 2009: 12th International Conference on Scientometrics and Informetrics, Rio de Janeiro, 
Brazil, July 14-17 . Vol. 2, pp. 619-630. 
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Overview

 Macroscopes and the Changing Scientific Landscape 15 mins

 Introduction to network science with sample maps and insights 15 mins
 Introduction to the Network Workbench Tool 15 mins
 Demo and hands-on data analysis and visualization by participants  60 mins 

 Introduction to science studies with sample maps and insights 15 minsp p g
 Introduction to the Sci2 Tool 15 mins
 Demo and hands-on data analysis and visualization by participants 60 mins
 Overview of validation approaches for science studies pp

 Plug-and-play tool design using OSGi/CIshell 30 mins 
 Scholarly Marketplaces 15 mins Scholarly Marketplaces 5 mins 

240 mins
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Type of Analysis vs. Scale of Level of Analysis

Micro/Individual
(1 100 d )

Meso/Local
(101 10 000 d )

Macro/Global
(10 000 d )(1-100 records) (101–10,000 records) (10,000 < records) 

Statistical 
Analysis/Profiling 

Individual person and 
their expertise profiles

Larger labs, centers, 
universities, research 
domains, or states

All of NSF, all of USA, 
all of science.

,

Temporal Analysis 
(When)

Funding portfolio of 
one individual

Mapping topic bursts 
in 20-years of PNAS

113 Years of physics 
Research

Geospatial Analysis 
(Where)

Career trajectory of one 
individual  

Mapping a states 
intellectual landscape

PNAS publications 

Topical Analysis Base knowledge from Knowledge flows in VxOrd/Topic maps ofTopical Analysis 
(What)

Base knowledge from 
which one grant draws.

Knowledge flows in 
Chemistry research 

VxOrd/Topic maps of 
NIH funding

Network Analysis 
(With Whom?)

NSF Co-PI network of 
one individual

Co-author network NSF’s core competency 
(With Whom?) one individual  
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Sci2 Tool Demo and Hands-on Data Analysis and Visualization

Micro/Individual (1-100 records)Micro/Individual (1 100 records)

o Mapping Collaboration, Publication and Funding Profiles of One Researcher 
(EndNote and NSF Data) (section 5.1.1) 

o Studying Four Major NetSci Researchers (ISI Data) using Database (section 5.1.5)y g j ( ) g ( )

Meso/Local (101–10,000 records)

o Mapping CTSA Centers (NIH RePORTER Data) (section 5.2.3)pp g ( ) ( )

o Biomedical Funding Profile of NSF (NSF Data) (section 5.2.4)

o Mapping the Field of RNAi Research (SDB Data) (section 5.2.7)

Macro/Global (10,000 < records)

o Geo USPTO (SDB Data) (section 5.3.1)
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Many researchers/publishers use EndNote to organize bibliographies. 

To analyze an individual researcher’s collaboration and publication profile, load anTo analyze an individual researcher s collaboration and publication profile, load an 
EndNote file into the Sci2 Tool, e.g., load the Katy Borner’s EndNote file at 
‘*yoursci2directory*/sampledata/scientometrics/endnote/KatyBorner.enw’ and run ‘Data 
Preparation > Text Files > Extract Co-Author Network’ using the parameter:p g p
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Next, run ‘Analysis > Networks > Unweighted & Undirected > Node Degree’ to append 
degree information to each node.  To visualize the network, run ‘Visualization > 
Networks > GUESS’ and select ‘GEM’ in the ‘Layout’ menu once the graph is fully 
loaded. Optimize layout design using the following workflow:
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Co-Author Network
This is a so called ego-centric 
network i e almost complete datanetwork, i.e., almost complete data 
is available and shown for exactly 
one ego. The publication 

records for all other 

authors in the network 

are most likely incomplete.
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Funding Data Analysis
Free online services such as NSF’s Award Search (See Section 4.2.2.1 NSF Award 
Search) support the retrieval of  ego-centric funding profiles. Here, a search was 
exemplarily conducted for “Katy Borner” in the “Principal Investigator” field while 
keeping the “Include CO-PI” box checked.

The resulting data is available at 
‘*yoursci2directory*/sampledata/scientometrics/nsf/KatyBorner.nsf.’ Load the data using ‘File 
> Load’ select the loaded dataset in the Data Manager window and run ‘Data> Load , select the loaded dataset in the Data Manager window, and run Data 
Preparation > Text Files > Extract Co-Occurrence Network’ using these parameters:
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Select the “Extracted Network on Column All Investigators” network and run ‘Analysis 
>Networks > Network Analysis Toolkit (NAT)’ to reveal that there are 13 nodes and 28 
edges in the network without isolates. Select ‘Visualization > Networks > GUESS’ to 
visualize the resulting Co-PI network. Select ‘GEM’ from the layout menu.

Load the default Co-PI visualization theme via ‘File > Run Script …’ and load 
‘*yoursci2directory*/scripts/GUESS/co-PI-nw.py’.  Alternatively, use the “Graph Modifier” 
to customize the visualization. The resulting network in Figure 5.2 was modified 
using the following workflow:
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Co-PI Network
This is a so called 

ego-centric network, 

i.e., almost complete 

data is available and 

shown for exactly 

one ego. The funding 

records for all other 

people in the network 

are most likely

incomplete.incomplete.
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Award Durations and Totals

For a summary of  the grants themselves, with a visual representation of  their award y g , p
amount, select the NSF csv file in the Data Manager and run ‘Visualization > Temporal 
> Horizontal Bar Graph’, entering the following parameters:

The generated postscript file can be viewed using Adobe Distiller or GhostViewer 
(see Section 2.4 Saving Visualizations for Publication).
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Mapping Collaboration, Publication and Funding 
Profiles of  One Researcher (section 5.1.1) 

Award Durations and Totals

A i l i l

St t d t E d d t

Area size equals numerical 
value, e.g., award amount.

Text, e.g., title

Start date End date
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Thomson Reuter’s Web of  Knowledge (WoS) is a leading citation database cataloging 
over 10,000 journals and over 120,000 conferences.  Access it via the “Web of  j
Science” tab at http://www.isiknowledge.com (note: access to this database requires 
a paid subscription).  Along with Scopus, WoS provides some of  the most 
comprehensive datasets for scientometric analysis.  

To find all publications by an author, search for the last name and the first initial 
followed by an asterisk in the author field. 
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Data Acquisition from Web of Science

Download all papers by

 Eugene Garfield

 Stanley Wasserman

 Alessandro Vespignani Alessandro Vespignani

 Albert-László Barabási

from

 S i Ci i I d Science Citation Index 

Expanded (SCI-EXPANDED)

--1955-present 

 Social Sciences Citation Index 
(SSCI)--1956-present 

 Arts & Humanities Citation 
Index (A&HCI)--1975-present 
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Comparison of Counts
No books and other non-WoS publications are covered.

Age Total # Cites Total # Papers H-Index

Eugene Garfield 82 1,525 672 31

Stanley Wasserman 122 35 17Stanley Wasserman 122 35 17

Alessandro Vespignani 42 451 101 33

Albert-László Barabási 40 2,218 126 47    (Dec 2007)

41 16,920 159 52    (Dec 2008)
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Extract Co-Author Network

Load*yournwbdirectory*/sampledata/scientometrics/isi/FourNetSciResearchers.isi’ 

using 'File > Load and Clean ISI File'.

To extract the co-author network, select the ‘361 Unique ISI Records’ table and run

'Scientometrics > Extract Co-Author Network’ using isi file format:g

The result is an undirected network of co-authors in the Data Manager. It has 247

nodes and 891 edges. 

To view the complete network, select the network and run ‘Visualization > 

GUESS > GEM’. Run Script > Run Script… . And select Script folder > GUESS >p p p f

co-author-nw.py.
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Joint Co-Author Network of all Four NetsSci Researchers
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Individual Co-Author Networks (Read/map 4 files separately)

Eugene Garfield Stanley Wasserman

Alessandro Vespignani Albert-László Barabási
101

Network Visualization:
Node Layout
Network Science researchers

Load and Clean ISI File was selected.
Loaded 361 records.
Removed 0 duplicate records.
Author names have been normalized.
361 records with unique ISI IDs are available via Data Manager.
..........
Extract Co-Author Network was selected.
Input Parameters:
File Format: isi
..........
Network Analysis Toolkit (NAT) was selected.
Nodes: 247
Edges: 891
..........
GUESS was selected.
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Network Visualization: 
Color/Size Coding by Data Attribute Values
Network Science researchers
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Network Visualization: 
Giant Component
Network Science researchers

..........
Weak Component Clustering was selected.
Implementer(s): Russell Duhon
Integrator(s): Russell Duhon

Input Parameters:
Number of top clusters: 10p
3 clusters found, generating graphs for the top 3 clusters.
..........

104



Network Visualization: 
Color/Size Coding by Degree
Network Science researchers

..........
Node Degree was selected.
Documentation:Documentation: 
https://nwb.slis.indiana.edu/community/?n=AnalyzeData.NodeDegree
..........
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Network Visualization: 
Color/Size Coding by Betweeness Centrality
Network Science researchers

..........
Node Betweenness Centrality was selected.
Author(s): L. C. Freeman
Implementer(s): Santo Fortunato
Integrator(s): Santo Fortunato, Weixia Huang
Reference: Freeman, L. C. (1977). A set of measuring centrality based on betweenness. 
Sociometry. 40:35-41.

Input Parameters:
N mber f bins 10Number of bins: 10

umber of bins: 10
..........
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Network Visualization: 
Reduced Network After Pathfinder Network Scaling
Network Science researchers

..........
MST P hfi d N k S li l d
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MST-Pathfinder Network Scaling was selected.
Input Parameters:
Weight Attribute measures: SIMILARITY
Edge Weight Attribute: weight
..........

Paper-Citation Network Layout

Load ‘*yournwbdirectory*/sampledata/scientometrics/isi/FourNetSciResearchers.isi’ using 
'File > Load and Clean ISI File'.File  Load and Clean ISI File .

To extract the paper-citation network, select the ‘361 Unique ISI Records’ table and run 
'Scientometrics > Extract Directed Network' using the parameters:

The result is a directed network of paper citations in the Data Manager. It has 5,335 
nodes and 9,595 edges. 

To view the complete network, select the network and run ‘Visualization > GUESS’.
Run ‘Script > Run Script …’ and select ‘yournwbdirectory*/script/GUESS/paper-citation-nw.py’.
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Replicate Studies Using Database Support

Load ‘*yoursci2directory*/sampledata/scientometrics/isi/FourNetSciResearchers.isi’, using y y / p / / / , g
‘File > Load’ instead of  ‘File > Load and Clean ISI File’.  

Run ‘File > Load Into Database > Load ISI File Into Database’.  View the database 
schema by right-clicking on the loaded database in the Data Manager and clicking y g g g g
“View”.
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Replicate Studies Using Database Support – Unification

Run ‘Data Preparation > Database > ISI > Merge Identical ISI People’, followed by ‘Data p g p , y
Preparation > Database > ISI > Merge Journals’ and ‘Data Preparation > Database > ISI > 
Match References to Papers’.  Make sure to wait until each cleaning step is complete 
before beginning the next one. Read red warnings.
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Using Database Support – Extract Basic Properties

Run ‘Data Preparation > Database > ISI > Extract Authors’ and right-click on the p g
resulting table to view all the authors from FourNetSciResearchers.isi.  The table also 
has columns with information on how many papers each person in the dataset 
authored, their Global Citation Count (how many times they have been cited 
according to ISI), and their Local Citation Count (how many times they were cited in 
the current dataset).
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Using Database Support – Records over time
Aggregate data by year by running ‘Data Preparation > Database > ISI > Extract Longitudinal gg g y y y g p g
Summary.’ Result is a table which lists metrics for every year mentioned in the dataset.  The 
longitudinal study table contains the volume of  documents and references published per year, 
as well as the total amount of  references made, the amount of  distinct references, distinct 
authors distinct sources and distinct keywords per yearauthors, distinct sources, and distinct keywords per year.  
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Using Database Support – Records over time
Aggregate data by year by running ‘Data Preparation > Database > ISI > Extract Authors > gg g y y y g p
Extract Longitudinal Study.’ Result is a table which lists metrics for every year mentioned in the 
dataset.  The longitudinal study table contains the volume of  documents and references 
published per year, as well as the total amount of  references made, the amount of  distinct 
references distinct authors distinct sources and distinct keywords per yearreferences, distinct authors, distinct sources, and distinct keywords per year.  
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Using Database Support – Burst Analysis for References

The queries can also output data specifically tailored for the burst detection q p p y
algorithm (see Section 4.6.1 Burst Detection).  Run ‘Data Preparation > Database > 
ISI > Extract Authors > Extract References by Year for Burst Detection’ on the cleaned 
database followed by ‘Analysis > Topical > Burst Detection’ with parameters on left and 
then run ‘Visualize > Temporal > Horizontal Bar Graph’ with parameters on right.

Watch those red warnings!
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Open HBG4NetSci.pdf
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Studying Four Major NetSci Researchers (ISI Data) 
using Database (section 5.1.5)

Using Database Support – Burst Analysis Result

early bursts
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early bursts

Topic Mapping: UCSD Science Map

JournalsScienceMap-FourNetSciResearchers.pdf
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Mapping CTSA Centers (NIH RePORTER Data) 
(section 5.2.3)

A study of  all NIH Clinical and Translational Science Awards (CTSA) awards and 
resulting publications from 2005-2009, requires advanced data acquisition and 
manipulation to prepare the required data.  Data comes from the union of  NIH 
RePORTER downloads (see Section 4.2.2.2 NIH RePORTER) and NIH 
ExPORTER data dumps (http://projectreporter.nih.gov/exporter/). CTSA Center 
grants were identified first and then matched with resulting publications using a 

j ifi D Th l fil i il bl l fil iproject-specific ID. The result file is available as an Excel file in 
‘*yoursci2directory*/sampledata/scientometrics/nih’. The file contains two spreadsheets, 
one with publication data and one with grant data.  Save each spreadsheet out as 
grants csv and publications csvgrants.csv and publications.csv.

119

Mapping CTSA Centers (NIH RePORTER Data) 
(section 5.2.3)

Data Preparation

Open ../nih/CTSA2005-2009.xls in p / /
MS Excel. It contains two worksheets: 
‘Grants’ and ‘Publications’.

Save  both worksheets separately as 
CSV (comma delimited) files, e.g., 

 CTSA2005-2009-Grants csv CTSA2005 2009 Grants.csv

 CTSA2005-2009-Publications.csv
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Mapping CTSA Centers (NIH RePORTER Data) 
(section 5.2.3)

Bimodal Network of  Funded 
Institutions and PIs
Extract Directed Network was selected.

Input Parameters:

Source Column: Organization Name

Text Delimiter: ||

Target Column: PI(s) Name

..........

Network Analysis Toolkit (NAT) was selected.

Nodes: 97Nodes: 97

Edges: 51
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Mapping CTSA Centers (NIH RePORTER Data) 
(section 5.2.3)

Topic Coverage of  Publications

Visualization > Topical > Science Map via Journals’ z p p J

122JournalsScienceMap-CTSA.pdf



Mapping CTSA Centers (NIH RePORTER Data) 
(section 5.2.3)

NIH CTSA Grants: Publication Co-Author Network 

Extract Co-Occurrence Network was selected.

Input Parameters:

Text Delimiter: ; ;

Column Name: Authors

..........

Network Analysis Toolkit (NAT) was selected.

Nodes: 8680Nodes: 8680

Isolated nodes: 27

Edges: 50160
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Mapping CTSA Centers (NIH RePORTER Data) 
(section 5.2.3)

Extract Largest (Giant) Component

Weak Component Clustering 

was selected.

Input Parameters:

Number of top clusters: 10Number of  top clusters: 10

535 clusters found

..........

Network Analysis Toolkit (NAT) 

was selectedwas selected.

Nodes: 3239

Edges: 24969

See Poster
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Biomedical Funding Profile of  NSF (NSF Data) 
(section 5.2.4)

What organizations and programs at the National Science Foundation support 
projects that deal with medical and health related topics? Data was downloaded from 
the NSF Awards Search SIRE (http://www.nsf.gov/awardsearch) on Nov 23rd, 2009, 
using the query “medical AND health” in the title, abstract, and awards field, with 
“Active awards only” checked (see section 4.2.2.1  NSF Award Search for data 
retrieval details).
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Biomedical Funding Profile of  NSF (NSF Data) 
(section 5.2.4)

Using NSF Awards Search:
http://www.nsf.gov/awardsearch
download relevant NSF awards that 
have “medical” AND “health”
i i l b d din title, abstract, and awards.
Active awards only. 

Number of awards: 283 awardsNumber of  awards: 283 awards
Total awarded amount to date: 
$152,015,288 

Retrieved on Oct 18, 2009
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Biomedical Funding Profile of  NSF (NSF Data) 
(section 5.2.4)

Horizontal Bargraph

Area size equals numerical 
value, e.g., award amount.

Start date End date

Text, e.g., title

Top-10 grants with highest $Awarded to Date:Top 10 grants with highest $Awarded to Date:
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Biomedical Funding Profile of  NSF (NSF Data) 
(section 5.2.4)

Horizontal Bargraph
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Biomedical Funding Profile of  NSF (NSF Data) 
(section 5.2.4)

Bimodal Network of  NSF Organization to Program(s)

Extract Directed Network was selected.
Source Column: NSF Organization
Text Delimiter: |
Target Column: Program(s)

Nodes: 167Nodes: 167
Isolated nodes: 0
Edges: 177
No parallel edges were discovered.
Did not detect any edge attributes
This network does not seem to be a valued network.
Density (disregarding weights): 0.00638
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Mapping the Field of  RNAi Research (SDB Data) 
(section 5.2.7)

How many papers, patents, and funding awards exist on a specific topic? y p p , p , g p p

Here we selected research on RNA interference (RNAi) is a system within living cells 
that helps to control which genes are active and how active they are. 

The data for this analysis comes from a search of the Scholarly Database (SDB)The data for this analysis comes from a search of  the Scholarly Database (SDB) 
(http://sdb.slis.indiana.edu/) for “RNAi” in “All Text” from MEDLINE, NSF, NIH 
and USPTO.  A copy of  this data is available in 
‘*yoursci2directory*/sampledata/scientometrics/sdb/RNAi’.  The default export format y y p p
is .csv, which can be loaded in the Sci2 Tool directly.
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Mapping the Field of  RNAi Research (SDB Data) 
(section 5.2.7)

Email: nwb@indiana.edu

Password: nwb

The Scholarly Database at Indiana University provides free access to 23,000,000 
papers, patents, and grants. Since March 2009, users can also download networks, e 

Password: nwb

p p , p , g , ,
.g., co-author, co-investigator, co-inventor, patent citation, and tables for burst 
analysis. For more information and to register, visit http://sdb.slis.indiana.edu.
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Mapping the Field of  RNAi Research (SDB Data) 
(section 5.2.7)

.Co-Author Network
Load ‘*yoursci2directory*/sampledata/scientometrics/sdb/RNAi/Medline_co-

h bl ( b f ) ’ d d fil SDB bl l d li dauthor_table_(nwb_format).csv’ as a standard csv file.  SDB tables are already pre-normalized, so 
now simply run ‘Data Preparation > Text Files > Extract Co-Occurrence Network’ using the default 
parameters.

Network Analysis Toolkit (NAT):
21,578 nodes with 131 isolates, 
77,739 edges.  

Extract only the largest component 
by running ‘Analysis > Networks > 
Unweighted and Undirected > g
Weak Component Clustering.’

Visualize with GUESS using 
‘Layout > GEM’
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Layout > GEM .  
Use a custom python script 
to color and size the network. 
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Mapping the Field of  RNAi Research (SDB Data) 
(section 5.2.7)

.Patent Citation 
Network

To visualize the citation 
patterns of  patents on 
RNAi loadRNAi, load 
‘*yoursci2directory*/sampl
edata/scientometrics/sdb/
RNAi/USPTO_citation
_table_(nwb_format).csv’ 
as a standard csv file 
and follow the 
instructions in theinstructions in the 
tutorial.
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Mapping the Field of  RNAi Research (SDB Data) 
(section 5.2.7)

.
Topic Bursts
Load ‘*yoursci2directory*/sampledat/scientometrics/sdb/RNAi/Medline_master_table.csv’. This table 
includes full records of  MEDLINE papers, and can be used to find bursting terms from p p , g
MEDLINE abstracts dealing with RNAi.

Load the file as a standard csv and run ‘Preprocessing > Topical > Normalize Text’ with the 
d f lt t d th “ b t t” b h k d R ‘A l i > T pi l > B t D t ti ’default separator and the “abstract” box checked.  Run ‘Analysis > Topical > Burst Detection’ 
with “date_cr_year” in the Date Column and “abstract” in the Text Column, leaving the rest 
of  the values default.

Right click on “Burst detection analysis (date_cr_year, abstract): maximum burst level 1” in 
the Data Manager and view the file.  There are more words than can easily be viewed with the 
horizontal bar graph, so sort the list by “Strength” and prune all but the strongest 10 words.  
Save the file as a new csv and load it into the Sci2 Tool as a standard csv fileSave the file as a new .csv and load it into the Sci2 Tool as a standard csv file. 
Select the new table in the data manager and visualize it using ‘Visualize > Temporal > 
Horizontal Bar Graph.’ 
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Geo USPTO (SDB Data) 
(section 5.3.1)

The file ‘usptoInfluenza.csv’ was generated with an SDB search for patents containing 
the term “Influenza”, and was heavily modified to produce a simple geographic table.  
Load it using ‘File > Load > sampledata > geo > usptoInfluenza.csv’ and then select 
‘Standard csv format’. See the data format in Figure 5.30 (left).  Once loaded, select 
the dataset in data manager and click ‘Visualization > Geo Map (Circle Annotation Style)’, 
inputting the parameters Figure 5.30 (right). The tool will output a PostScript 
i li i hi h b i d i Gh Vi ( i 2 4 Svisualization which can be viewed using GhostView (see section 2.4 Saving 

Visualizations for Publication and Figure 5.31).
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Geo USPTO (SDB Data) 
(section 5.3.1)
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Geo USPTO (SDB Data) – Circle Coding 
(section 5.3.1)

Open GeoMapsCircles-USPTO pdfOpen GeoMapsCircles USPTO.pdf
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Geospatial Maps – Region Coding
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Geo USPTO (SDB Data) – Region Coding 
(section 5.3.1)

Open GeoMapRegions-USPTO pdfOpen GeoMapRegions USPTO.pdf
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http://sci.slis.indiana.edu
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Overview

 Introduction to the Sci2 Tool

 Demo and hands-on data analysis and visualization by participants 

 O l k Outlook

 Overview of validation approaches for science studies 
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Bollen, Johan, Herbert Van de Sompel, Aric Hagberg, Luis M.A. Bettencourt, Ryan Chute, Marko A. Rodriquez, 
Lyudmila Balakireva. 2008. A Clickstream Map of Science. 142



Council for Chemical Research. 2009. Chemical R&D Powers the U.S. Innovation Engine. 
Washington, DC. Courtesy of  the Council for Chemical Research. 143

Herr II, Bruce W., Gully Burns, David Newman, Edmund Talley. 2007. 
A Topic Map of  NIH Grants 2007. Bloomington, IN. 144



Science Maps in “Expedition Zukunft” science train visiting 62 cities in 7 monthsScience Maps in Expedition Zukunft  science train visiting 62 cities in 7 months 
12 coaches, 300 m long
Opening was on April 23rd, 2009 by German Chancellor Merkel
http://www.expedition-zukunft.de 145

Validating Science Maps
Boyack, Kevin W., Klavans, Richard & Börner, Katy. (2005). Mapping the Backbone of  Science. 
Scientometrics Vol 64(3) 351 374Scientometrics. Vol. 64(3), 351-374. 

Eight alternative measures of 
j l i il i li djournal similarity were applied to a 
data set of 7,121 journals covering 
over 1 million documents in the 
combined Science Citation and 
Social Science Citation Indexes. For 

h j l i il ieach journal similarity measure we 
generated two-dimensional spatial 
layouts using the force-directed 
graph layout tool, VxOrd. Next, 
mutual information values were 

l l t d f h h tcalculated for each graph at 
different clustering levels to give a 
measure of structural accuracy for 
each map. The best co-citation and 
inter-citation maps according to 
l l d t t llocal and structural accuracy were 
selected and are presented and 
characterized. These two maps are 
compared to establish robustness. 
The inter-citation map is then used 
t i li k b tto examine linkages between 
disciplines. 
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Validating Science Maps
Klavans, R., & Boyack, K. W. (2009). Toward a consensus map of  science. Journal of  the 

American Society for Information Science and Technology 60(3) 455 476American Society for Information Science and Technology, 60(3), 455-476.

A consensus map of science is generatedA consensus map of science is generated 
from an analysis of twenty existing maps of 
science. These twenty maps occur in three 
basic forms: hierarchical, centric, and non-
centric (or circular). The consensus map, 
generated from consensus edges that occur ingenerated from consensus edges that occur in 
at least half of the input maps, emerges in a 
circular form. The ordering of areas is as 
follows: mathematics is (arbitrarily) placed at 
the top of the circle, and is followed 
clockwise by physics physical chemistryclockwise by physics, physical chemistry, 
engineering, chemistry, earth sciences, 
biology, biochemistry, infectious diseases, 
medicine, health services, brain research, 
psychology, humanities, social sciences, and 
computer sciencecomputer science. 
The circular map of science is found to have a 
high level of correspondence with the twenty 
existing maps, and has a variety of advantages 
over hierarchical and centric forms. 
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Validating Science Maps

Accuracy of  Models for Mapping the Medical Sciences 
Kevin W. Boyack, Richard Klavans, SciTech Strategies Inc. 
Katy Börner, Russell J. Duhon, Nianli Ma, Indiana 
University, Bob Schijvenaars, Aaron Sorensen, Collexis 

d dHoldings Inc., André Skupin, San Diego State University 

This project aims to provide a highly accurate 
interactive map of medical research that can be p
easily used by both technical and non-technical 
users. Phase I of this project compares and 
determines the relative accuracies of maps of 
medical research based on commonly used text-
based and citation-based similarity measures at a 
scale of over two million documents. 

All work is documented in real time at 
http://sci.slis.indiana.edu/sts and at a level of 
detail that supports the exact replication of work.
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Overview

 Macroscopes and the Changing Scientific Landscape 15 mins

 Introduction to network science with sample maps and insights 15 mins
 Introduction to the Network Workbench Tool 15 mins
 Demo and hands-on data analysis and visualization by participants 60 mins 

 Introduction to science studies with sample maps and insights 15 minsp p g
 Introduction to the Sci2 Tool 15 mins
 Demo and hands-on data analysis and visualization by participants 60 mins
 Overview of validation approaches for science studies pp

 Plug-and-play tool design using OSGi/CIshell 30 mins 
 Scholarly Marketplaces 15 mins Scholarly Marketplaces 5 mins 

240 mins
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CIShell – Serving Non-CS Algorithm Developers & Users

Developers Users

CIShell
IVC InterfaceCIShell Wizards

NWB Interface
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CIShell – Builds on OSGi Industry Standard

CIShell is built upon the Open Services Gateway Initiative (OSGi) Framework. 

OSGi (http://www.osgi.org) isOSGi (http://www.osgi.org) is 
 A standardized, component oriented, computing environment for networked services. 
 Successfully used in the industry from high-end servers to embedded mobile devices 

since 8 years.
 Alliance members include IBM (Eclipse) Sun Intel Oracle Motorola NEC and many Alliance members include IBM (Eclipse), Sun, Intel, Oracle, Motorola, NEC and many 

others.
 Widely adopted in open source realm, especially since Eclipse 3.0 that uses OSGi R4 

for its plugin model.

Advantages of Using OSGi
 Any CIShell algorithm is a service that can be used in any OSGi-framework based 

system.
 / / Using OSGi, running CIShells/tools can connected via RPC/RMI supporting peer-to-

peer sharing of data, algorithms, and computing power.

Ideally, CIShell becomes a standard for creating OSGi Services for algorithms. 
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CIShell – Converter Graph

 No central data format.

 Sci2 Tool has 26 external and internal data formats and 35 converters.

 Their relationships can be derived by running ‘File > Converter Graph’ and 
plotted as shown here. Note that some conversions are symmetrical (double 
arrow) while others are one-directional (arrow).
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CIShell – Add new Plugins, e.g., Cytoscape

 Not all code can be shared freely (yet).

 To make the UCSD Science Map and Cytsocape tool available via the Sci2

menu, simply add

to the ‘yourdirectory/plugin’ directory and restart the tool. 

 To delete algorithms that you do not use simply delete the corresponding To delete algorithms that you do not use, simply delete the corresponding 
*.jar files in the plugin directory.

 Customize your menu structure accordingly—see next slide.
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CIShell – Customize Menu

 The file ‘yourtooldirectory/configuration/default_menu.xml’ encodes the structure of 
the menu system.

 In NWB Tool, the Modeling menu (left) is encoded by the following piece of 
xml code: 
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CIShell – Integrate New Algorithms

http://cishell.org/?n=DevGuide.NewGuide
159

Tools that Use OSGi and/or CIShell

CIShell/OSGi is at the core of different CIs and a total of 180 unique plugins are used in the 
- Information Visualization (http://iv.slis.indiana.edu), 
- Network Science (NWB Tool) (http://nwb.slis.indiana.edu), 
- Scientometrics and Science Policy (Sci2 Tool) (http://sci.slis.indiana.edu), and 
- Epidemics (http://epic.slis.indiana.edu) research communities. 

Most interestingly, a number of other projects recently adopted OSGi and one adopted CIShell:
Cytoscape (http://www.cytoscape.org) lead by Trey Ideker, UCSD is an open source bioinformatics 

software platform for visualizing molecular interaction networks and integrating these interactions 
with gene expression profiles and other state data (Shannon et al., 2002). 

Taverna Workbench (http://taverna.sourceforge.net) lead by Carol Goble, University of 
Manchester UK is a free software tool for designing and executing workflows (Hull et al 2006)Manchester, UK is a free software tool for designing and executing workflows (Hull et al., 2006). 
Taverna allows users to integrate many different software tools, including over 30,000 web 
services.

MAEviz (https://wiki.ncsa.uiuc.edu/display/MAE/Home) managed by Shawn Hampton, NCSA is 
an open-source, extensible software platform which supports seismic risk assessment based on 
the Mid America Earthquake (MAE) Center researchthe Mid-America Earthquake (MAE) Center research.

TEXTrend (http://www.textrend.org) lead by George Kampis, Eötvös University, Hungary 
develops a framework for the easy and flexible integration, configuration, and extension of 
plugin-based components in support of natural language processing (NLP), classification/mining, 
and graph algorithms for the analysis of business and governmental text corpuses with an 
i h l linherently temporal component.

As the functionality of OSGi-based software frameworks improves and the number and diversity of 
dataset and algorithm plugins increases, the capabilities of custom tools or macroscopes will expand. 
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Overview

 Macroscopes and the Changing Scientific Landscape 15 mins

 Introduction to network science with sample maps and insights 15 mins
 Introduction to the Network Workbench Tool 15 mins
 Demo and hands-on data analysis and visualization by participants 60 mins 

 Introduction to science studies with sample maps and insights 15 minsp p g
 Introduction to the Sci2 Tool 15 mins
 Demo and hands-on data analysis and visualization by participants 60 mins
 Overview of validation approaches for science studies pp

 Plug-and-play tool design using OSGi/CIshell 30 mins 
 Scholarly Marketplaces 15 mins Scho a y Ma etp aces 5 mins 

240 mins
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Network Workbench Community Wiki
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https://nwb.slis.indiana.edu/community



Epidemics Marketplace

http://dev.epic.slis.indiana.edu
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VIVO National Network of  Researchers
(see also Eagle-I National Network of  Resources)

 Semantic web Semantic web 
application + ontology 
editor developed at 
Cornell.

Enables discovery of  
research and 

h l r hip rscholarship across 
multiple schools.

Facilitates cross-
disciplinary 
collaboration.
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http://vivoweb.org



Question-Answer Session

All questions are welcome.

W i i hi li f l d l i h i iWe appreciate your input to this line of tool development via the questionnaire.

Feel free to fax it back via (812) 855-6166.

Thank you.
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All papers, maps, cyberinfrastructures, talks, press are linked 
from http://cns.slis.indiana.edu
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